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Computer Basics
The Operating System’

The operating system is the most important program that runs on a computer. Every general-
purpose computer must have an operating system to run other programs. Operating systems
perform basic tasks such as recognizing inputs from the keyboard, sending outputs to the
display screen, keeping track of files and directories on the disk, and controlling peripheral
devices such as disk drives and printers.

Application

fDisk Drive

Ciperating

ke vboard Printer

For large systems, the operating system has even greater responsibilities and powers. It is like
a traffic cop — it makes sure programs and users running at the same time do not interfere with
each other. The operating system is also responsible for security, ensuring that unauthorized
users do not access the system.

Operating systems provide a software platform on top of which other programs, called
application programs, can run. The application programs must be written to run on top of a
particular operating system. Your choice of operating system, therefore, determines to a great
extent the applications you can run. For PCs, the most popular operating system is Windows,
but others are available, such as Linux. For Macintosh, there is only one operating system, the
Macintosh operating system.
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http://stats.macewan.ca/learn/students/tutorial/glossary/index.htm#0): the remaining content of this
section - developed by Kylie Kidd Wagner




e To determine which Operating System you’re using:

M ey
1. Click on the button in the bottom left hand corner of the screen
2. Select Control Panel
3. Under Control Panel select System
4

. Under the General tab within the System Properties window that appears, note the
Operating System

5. Click the Cancel button to close the System Properties window

System Properties

EumputerName Hardware | Advanced | Remate

System:
Microsoft “Windows =P
Profezzional

Yerzion 200
Service Pack 2

Registered to:
[nformation Systems
Capital Health
BR27A-B42-0227316-23818

Computer;
HPep2 w71 - 02/2009
Info. Centre - F80.735.4367
Intel[R]
Pentium[R =3
273 GHE, 504 MB of RaM

[ Support Information ]

[ QE. H Cancel ]

e To determine how much RAM your computer has :

1. Follow steps 1-3 listed above which outline how to determine which Operating System
you're using

2. Under the General tab within the System Properties window that appears, note the
amount of RAM your computer has

3. Click the Cancel button to close the System Properties window



The Control Panel ?

The Control Panel is full of specialized tools that are used to change the way your computer

looks and functions.

Consult the Help and Support Center under the_Help Menu within the Control Panel Window for

more details about the various settings and tools available to you.

B Control Panel

File Edit \Miew Favorites

Tools

§ @ Help and Support Center -

=
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Address |[} Cantrol Panel

d =

{ —l
| ,_‘.{-/ JJ
Folder Options Fonks
Lo *
D e

Mouse Metwiork,
Connections

@

Program Regional and

]
*

Downlo,,.  Language ...
(5
O 9
Security Sounds and
Cenker Audio Devices

= 0
Taskbar and Windows
Start Menu CardSpace

; 4= | \E
Is this copy of \Windows legal?
w
| About Windows |
= - ~
D % P
Add or Administrative Date and Time Display
Remoty... Tools
o k J'u:
S &=
e
Game Java Plug-in Kevboard Ml
Controllers
@ﬁ @/ ) =
Phone and  Portable Media Power Options  Printers and
Modem ... Devices Faxes
[} a
E O 8 B
Remate Fun Scanners and  Scheduled
Conkrol Advertis. .. Zameras Tasks
g @ ¥
Speech Swmantec Syskem Syskems
Livellpdate Managerenkt
& <
Windows Wireless
Firewall Mebwork Set... =

[ £

Opens Help.

2 The Control Panel Section — adapted from
http://www.microsoft.com/resources/documentation/windows/xp/all/proddocs/en-

us/cpanel overview.mspx?mfr=true




e To Change your Taskbar Settings:

Click on the m button in the bottom left hand corner of the screen

1.

2. Select Control Panel

3. Within the Control Panel window select the Taskbar and Start Menu option
4. Explore!!

Taskbar, and Start Menu Properties

Tazkbar | Start Menu!

T azkbar appearance

[% Ty i [[2) 2 welcome..,

[ Lock the taskbar
[ ] &uto-hide the taskbar
K.eep the tazkbar on top of ather windows

[ ] Group zimilar taskbar buttonz
Show Guick Launch

Matification area

) illtg 1:23 PM

Show the clock,

Y'ou can keep the notification area uncluttered by hiding icons that you
have not clicked recently.

Hide inactive icons

[ ak. H Cancel H Apply ]

Not sure about a function? — try right clicking on the option of interest for the “What’s this?”
pop up help

Lp Sil'l'l;l-" ke el e b ibbmie s

i Gt

5. Once you’ve selected the taskbar function settings you think are useful — select the
Apply button to implement your changes



Customizing Your Desktop — Creating Shortcuts °

Shortcuts can be made for easy access to applications, drives, folders etc... which are
commonly employed by the user.

e To create a Shortcut (icon) on your Desktop, take the following steps:

1. Right click on the application/drive/folder of interest

2. Select the Send to option, then the Desktop (create shortcut) option from the Menu that
appears

Open
Fun as...

Scan Far Yiruses, .,

Cuk | Mail Recipient
-opy D My Documents

Create Sharkcut 0 Matepad
Delete

Fename

Properties

8 Customizing your Desktop — Creating Shortcuts Section — developed by Kylie Kidd Wagner



e To create an Excel 2003 shortcut:

Option 1
P s
1. Click on the button in the bottom left hand corner of the screen
2. Find the Excel 2003 application within the Start Menu options
3. Right click on the Excel 2003 option
4. Select the Send to option, then the Desktop (create shortcut) option from the Menu that

appears
5. Check the Desktop to see if the Excel 2003 icon has appeared

- Clinical spplications 3
- Financial Applications 3
’ Local Applic:

@% Access 97
Access 2000

Sort by Mame

Log Off kyliekiddwagrer. .. Properties

@ Progams y B Command Prampt
|_-:e‘ Dacuments H @& Internet Explon
. [E] outlock 2003 | IEETERE
-’ Settings P = .
@ PowerPaink 200 Cuk __1 Mail Recipient
/J Seatch ¥ |3 Windaws Explor  Copy £} My Documents
ﬂ Help and 5 k @ ord 2003 Create Shorbout 3 Mokepad
) TIEp and auppor Delete
o T Rename
@

Shut Dowr, ..




To create an Excel 2003 shortcut continued...

Option 2

1. Use the steps outlined in the To Change your Taskbar settings section of this manual to
get to the window below
Select (check) the Show Quick Launch option

Click the Apply button
Click the OK button

Taskbar and Start Menu Properties

Tazkbar | Start e

Taskbar appearance

[:E . -~ 2 Welcorne,.,

[] Lack the taskbar
[] suta-hide the taskbar
k.eep the tazkbar on top of other windows

| Show Quick Launch

Matification area

)l e 1:23 PM

Show the clock

You can keep the notification area uncluttered by hiding icons that you
have naot clicked recently.

Hide inactive icons

[ (] H Cancel ][ Apply ]

5. Drag the Excel Desktop icon (you created using Option 1) and drop it onto your Quick
Launch Taskbar



My Computer *

In addition to other important functions, your computer acts as a file management system —
much like a big filing cabinet which holds various files (e.g. individuals by last name) within
designated folders (e.g. A-K, L-Z) where the different drawers act like the various ‘Drives’ (e.g.
your C:\ drive) available to you.

¢ My Computer

File Edit ‘iew Favorites Tools  Help |',"
() Each ] ¥ | F | @ PO seach | [ Folders | YA B9 x| 4| &
Address | i My Computer v|
[arie pE Takal Size Free Space  Comments
Hard Disk Drives
S (01 KP_NTFS Local Disk. 37.2GE 24,7 B

Devices with Removable Storage

L4{D1) CD Drive €D Drive
% (E:) Femovable Disk, Remaovable Disk

Network Drives

0G0 PO Mebwark Drive 339 GE 13,2 GB
S#(H:) Personal Metwork, Drive 472 GB 231 0GB
E(L:) Disconnected Metwork Drive

* My Computer Section — developed by Kylie Kidd Wagner
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Hierarchy of File Management — Drive - Folders - Files °

This is the hierarchy of the file management system on a computer — Drives contain Folders
(a.k.a. Directories) which contain individual files.

Example — the C:\ Drive contains the AIM Folder which contains the New Microsoft Excel
Worksheet.xls file.

% My Computer

File Edit \igw Faworites  Tools  Help #
&) Back (] | F Poearch [HFdes | XD B QX 4 E-

Address | j My Compuker
Mame Tvpe Taotal Size Free Space  Comments

Hard Disk Drives

e (C) KP_NTFS Local Disk, 32 6B 24,7 B

File Edit  “iew Favorites  Tools  Help ,&

&3 Bark (5] | @ Psearch [[HFdes | ¥ | D B 9| X -

Address |w =5} Vl
T Size | Type Date Modified |
Chamm File Folder 7lal2009 3:28 PM b
File Edik  Miew Favorites  Tools  Help #
& Back (5] Z & | @ Posarch [Hrdders | X [ B | 9| X -
Address |&) CAAIM v|
hilan Size | Type - Date Modified
@New Microsaft Excel Worksheet, xls 12 KB Microsoft Excel Worksheet  7/8/2009 3:28 PM
1 objects 11.5KB i My Computer

° Hierarchy of File Management — Drive (| Folders [ Files Section — developed by Kylie Kidd Wagner
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Folder Options °

The organization of files within a folder can be customized to suit the user through Folder
Options.

-EB)X
'!f

File Edit ‘iew  Favorites Help
aﬁack = 3] ? Map Mebwork Drive. .. = X LI:I E HJ x |£| v

Disconnect Mebwork Drive. ..
iy J
Hame - W Date Modfied
@I_jr'-.lew Microsoft Excel Workshests T2 R icre=lt Excel Worksheet Flalz2009 3128 PM
E;]New Microsoft PowerPaoint Presentation, ppk 13 KB Microsaft PowerPaint Presentation 771002009 11:48 AM
EI_]NEW Microsoft Waord Document, doc 11 KB  Microsoft \Waord Document TI0Z009 11:48 AM

Address |@ il AIM

Enables you ko change settings.

® Folder Options Section — developed by Kylie Kidd Wagner
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e To customize your Folder Options:

1. Under the Tools Menu — select Folder Options

2. Within the Folder Option Window that appears — explore the various tabs — try it and
apply it !!

Folder Options

General | Yiew | File Types | Offine Files |
Tasks
() Show common tasks in folders
(%) Use Windows classic folders
Browse folders

ﬁ (%) Open each folder in the zame window
() Open each folder in itz own window

Click tters a3 follows
O Single-chck to open an item [point to select)

(%) Double-click to open an item [single-click to select)

I Restore Defaults |

[ Ok ” Cancel ]

** Not sure about a function? — try right clicking on the option of interest for the “What’s this?”
pop up help

Lp Sil'l'l;l-" ke el e b ibbmie s

i Gt
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To customize your Folder Options continued...

The View tab

Select the Restore to Default button to observe the default settings
Next, customize how files within your folders will be viewed
Pay attention to:

a. Hide extensions for file types

b. Remember each folders view settings

c. Show pop-up description for folder and desktop items

4. Once you've selected the settings of interest — click the Apply button to implement your
changes in the folder of interest OR click the Apply to All Folders button to have the
changes implemented in all folders

Folder Options

General | View | File Types | Offline Files|

Folder vigws %
You can apply the view [zuch az Detailz or Tiles] that

wou are using for thiz falder to all folders.

I Apply to All Folders ] [ Rezet All Folders

Advanced settings:
| I=5) Filez and Folders |
[] Automatically zearch for netwark folders and printers
Diizplay file size information in folder tips
Dizplay zimple folder view in Explorer's Folders list
[ ] Display the contents of system folders
Dizplay the full path in the address bar
Drizplay the full path in the title bar
[] Do ret cache thumbnails
[ Hidden files and folders
(%) Do not show hidden files and folders
() Show hidden files and folders
|_:| _Hiu:Ie extenzions far known file types )L

[ Restore Defaults

0K, H Cariel ]
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Customizing the View for Files within a Specific Folder”

Within the View tab of the Folder Options (see previous section), there is the option to
Femember each folder'z

wiew sethings

, which allows the user to customize the view of files within a

=1

specific foldef.

This option preserves the most recent view setting specific to the folder of interest.

AEE

File Edt View Favarites Tools Help :;
(3 Back 3] ¥ F | | Poseach Zrodes | X\NQ B 9 X | H| E-
address |E3 ciamm N\ |
Mame Size | Type [rake Modified

& Mew Microsoft Excel Workshest, xls 12 KB Microsoft Excel Worksheet \7[8/2009 3:28 PM
B ew Microsoft Word Document. doc 11 KB Microsoft Word Document 7N0f2009 11:45 aM
E;]New Micrasoft PowerPoink Presentation, ppt L13KE Microsoft PowerPaint Pr...  7/1082009 11:48 AM

Thumbnails
Tiles

Arrange Icons By

Icons
Refrash

List

Customize This Folder ... & Details

Paste
Paste Shaorbeut
Undo Delete

Chr+Z
Tew

Properties

! Customizing the View for Files within a Specific Folder Section — developed by Kylie Kidd Wagner
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To change the View settings in a folder:

1. Within the Folder Window, right click in the white space where the files are listed and
select the view of interest from the Menu that appears

B

File Edit ‘iew Favorites Tools  Help f,
.3 Back 5] T | | Pk rroders | X | [H| B B X | M| E-
Address |k'f} CHATM b |
Mame Size  Type Date Modified
EHMew Microsoft Excel Workshest, xls 1ZKB Microsoft EXse Worksheet  7/8/2009 3:28 PM
B Mew Microsaft Ward Document, doc 11 KB  Microsoft Word Dsqurnent 77102009 11:48 aM
E;]New Microsoft PowerPoint Presentation, ppt 13KE Microsoft PowerPoint PRy, 7/10/2009 11:45 AM
Thurnbnails
A : z ) Tiles
Rrrfang: cons By T ons
Fires List
Customize This Folder. .. ® Details
Paste
Paste Shorkout ‘v
IUndo Delete Ctr+Z
=0 3
Properties
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NOTE: within the Details View option, you can select the “details” you would like displayed by
right clicking on the title bar and checking the ones you

File Edit Wiew Favoribes Tools  Help

=

{3 Bact 3] ¥ | F | F| Poearch |PFoders | X | BB 9| X | 4| @

Address £ CiyaIM v

Mame Size  Twpe Date Modified
B Mews Microsoft Excel Waorksheet, xds 12KB Microsoft Excel Workshest 71802003 3:28 PM Y G
] M Microsoft Word Document. doc 11 KB Microsoft Word Docurnent 7/10/2009 11:45 AM v Type
EL]Mew Microsoft PowerPoink Presentation.ppt 13 KB Microsoft PowerPaoint Pr...  Fi10/2009 11:48 AM  Date Modified

Date Created
attributes
Chwner
Author

Title
Zomments
Artisk

Album Title
Year

Track Murber
Genre

Duration

Bit R.ate
Protected
Carmera Model

Mare. ..

3 objects

d [y Compuker
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e Tochange how files are arranged within a folder:

1. Follow the steps list above, but this time select the Arrange Icons by option from the
Menu list that appears

2. Try out the different arrangement options

& AlM - BX
File Edit ‘iew Favorites Tools  Help .1."
0 > > § F | O search “ Folders o L|:] B 9| x| | E-
Address ||.'f,\ C:hAIM \ b |
Mame Size \NQJE Date Modified
E]New Microsoft Excel Worksheet, xls 12KB  Mickdgoft Excel Worksheet  7/8/2009 3:28 PM
B pewy Microsoft Word Document. doc 11 KB MicrosoRt Word Document 7/10/2009 11:48 AM
@NEW Microsaft PowerPoink Presentation. ppt 13KE Microsoft RowerPoink Pr...  7J10/2009 11:43 AM
View L4
Marme
Refresh Size
Type
Customize This Folder, ..
# Modified
Past '
R Show in Groups
Undo Delete Chrl+2
Mew k
Properties

3. Alternatively, if you have the Details View selected, you can arrange your files by the
detail titles — simply click on the title bar descriptor of interest and the files will be
arranged in order (e.g. alphabetical order)
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